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1. Report Writing
1.1 Report writing Overview.
Personnel Director comes with many built in reports, which are available to use as soon as you have entered your
employee records on to the database, however you may wish to edit the existing reports or create ones of your
own.
Reports are ideal for analysing data from Personnel Director as data can be compared in groups showing totals or
they can be summarised. These reports can be saved and used over again. Note: Reports are dynamic. Each time
the report is run, it will show data as it appears at that time.
Reports can be as complex as required retrieving information from one or more Personnel Director tables based
on complex search criteria.

1.2 Creating a New Report using the Wizard
For best results, use the Report wizard to select the data you wish to view in your report, BUT change the criteria,
such as filters and sorting whilst Editing the report.
To make changes to a report or to design a new report you must be in the report Edit Mode.
The Edit mode shows 3 different views, identified by 3 separate tabs in the top right of the report window. These
are:
• Data
• Design
• Preview
There are 3 main types of reports
•
A Detailed (or list) Report - displays all detail relating to the report such as names in a simple list
•
A Grouped Report – Shows details grouped by a field in the database, E.G. a list of names by dept.
•
A Summary Report - simply calculate totals for example, headcount by department
Finally there are two key stages to creating reports. The first is to set up the DATA (choose the fields to be used in
the report etc), the second stage is to DESIGN the report using the chosen data.

The following examples aims to take you through the process for creating the 3 main types of reports.
1.2.1 A Detailed Report
This is typically the most basic type of report as it simply lists the selected values.
In this example we are creating a simple phone list including departments):
Setting up the Data
1. Click on the Reports button
2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder)
3. Click the NEW REPORT button on the toolbar this takes you straight into the wizard
4. Click OK
5. Choose the tables you wish to use (in this case, Employee Details) and click Next
6. Click on the CHOOSE FIELDS option then select the fields you wish to use (in this example, choose
Surname, Firstname, Department and Work Telephone) and click Next
7. Click Next 4 times
8. Type in a name for this report in the Description box (DO NOT ENTER ANYTHING INTO THE DATA
PIPELINE NAME Box), then click Finish.
9. This will then show you a preview of the data selected.
10. You should now be looking at the Preview Data window. Click OK to close this window.
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We will come back into the DATA tab later to make some changes.
Setting up the design
1. Click on the DESIGN TAB
2. Choose NEW from the FILE drop down menu (DON’T CHOOSE NEW REPORT)
3. Click OK
4. We will use all the available fields for this report (these were selected during the Data section above),
click on the right pointing double arrow button
5. Click NEXT
6. We don’t want to group this report, click NEXT
7. Click NEXT twice
8. Click Finish
This then shows the report in the Preview window.
Once you have completed the above steps you will be required to make some changes to both the DESIGN of the
report to make it look better and to the DATA tab to the information is sorted correctly etc. These will be discussed
later.
1.2.2 A Detailed Grouped Report
For this example we will re-create the above report from scratch and make one change to show the same
information in a completely different way, by grouping the data by the department field so that we will now have a
Phone list by department rather than a simple list.
Setting up the Data
1. Click on the Reports button
2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder)
3. Click the NEW REPORT button on the toolbar this takes you straight into the wizard
4. Click OK
5. Choose the tables you wish to use (in this case, Employee Details) and click Next
6. Click on the CHOOSE FIELDS option then select the fields you wish to use (in this example, choose
Surname, Firstname, Department and Work Telephone) and click Next
7. Click Next 4 times
8. Type in a name for this report in the Description box (DO NOT ENTER ANYTHING INTO THE DATA
PIPELINE NAME Box), then click Finish.
9. This will then show you a preview of the data selected.
10. You should now be looking at the Preview Data window. Click OK to close this window.
We will come back into the DATA tab later to make some changes.
Setting up the design
1. Click on the DESIGN TAB
2. Choose NEW from the FILE drop down menu (DON’T CHOOSE NEW REPORT)
3. Click OK
4. We will use all the available fields for this report (these were selected during the Data section above),
click on the right pointing double arrow button
5. Click NEXT
6. Double click on DEPARTMENT from the Available Fields window, this will add it to the Groups window
below. The right hand window simply shows how the report will now look), Click Next
7. Click NEXT twice
8. Click Finish
ESSENTIAL TIP: With a grouped Report it is imperative that you sort the report by the field which it is
being grouped by. To do this, simply click on DESIGN, click on the A-Z button and double click on the
grouped field, in this case Department.
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Preview the report to see the difference now that we have added a group. You will also see in the DESIGN view
that additional sections have been added to the layout of the report.

1.2.3 A summary Report
Following on from the above theme we will now show a similar report, which shows the number of employees by
each department but which doesn’t list their names. This is called a summary report.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.

A.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click on the Report button.
Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder)
Click the NEW REPORT button on the toolbar this takes you straight into the wizard
Click OK
Choose the tables you wish to use (in this case, Employee Details) and click Next
Click on the CHOOSE FIELDS option then select the fields you wish to use (in this example, we only
need to choose the field which will be used to give us our total, in this case Department) then click Next
Click Add Calculations.
Create a Headcount calculation by, double clicking on any text field from the Employee Details screen
(i.e. Employee Number).
Then choose Count as the Calculation. When you click OK, the calculation will look as follows, Count(*).
Next
Select Group Fields will automatically select the fields chosen in step 9.
Next
Next
Next
Enter a name for the report.
Finnish
Click on OK to close the Preview Data screen
Follow the Design section below to create the actual report.

DESIGN - Create the report and edit the layout.
Click on the design Tab
Select New From File menu
Choose Report Wizard, click OK
Choose fields (these are the fields chosen in the Data section) i.e. Department & Count(*).
Click Next
Next
Next
Next
Finnish

You should automatically be shown the preview. Again you will need to tidy up the layout of the report etc.
Now that you have seen the 3 main types of report, the following explains more about the DATA and DESIGN tabs
so that you can make changes to the report once it has been created.

1.3 DATA tab Overview
The Data tab is where we make changes to the actual content of the report, for example, choose additional fields,
change the sort order, add filters to the report etc. Everything here is done using the Query Designer.
1.3.1 To add another field for use in the report
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1.
2.
3.

Click on the FIELDS Button (2nd button on the toolbar)
Scroll down to find the field you wish to add and double click on it (for example, Work Telephone)
It should appear in the Selected Fields view (bottom section of the screen)

NOTE: This will not automatically add the field in the DESIGN TAB and therefore will not be displayed
automatically within the report. If you want this field to appear on the report, then you need to add it using
the tools in the DESIGN TAB
1.3.2 To change the sort order to Surname, Firstname:
1.
2.
3.
4.

Click on the A-Z button in the data tab.
Double click on the fields we wish to sort, in this case, Department and Surname.
This will move these fields into the Selected fields view (bottom section of the screen.)
Click OK

If you wish to change the order, you will have to remove these fields from the Sort Fields (bottom) window by
double clicking on them again.
1.3.3 Setting up a filter within the report (search)
You may wish to only view a selection of data within you report rather than show all the available records, for
example you may wish to show only the employees within a particular department or of a specific Gender etc.
To do this you will need to set up a filter within the field you wish to search on. In this example we will search for all
the Males within the company.

To add the filter (Search):
1.
2.
3.
4.
5.

Click on the Search button (Magnifying Glass Icon).
Choose the field you wish to filter, i.e. Gender and double click on it. This will add it to the CRITERIA
window in the bottom half of the Query Designer
Under OPERATOR you will see an EQUALS ‘=’ sign. To change this, click on it and choose another
option from the drop down. We will leave it as EQUALS for this example.
In the next box, the VALUE box, Type in the word “Male” (exactly as it appears in the database). You
may need to click under the word VALUE to make the input box active.
Click OK.

To view the changes in the DATA TAB, click on the Preview button.
To view the changes on the actual report, click on the PREVIEW TAB
Other Filters (SEARCH OPERATORS)
The following is an explanation of the different kinds of filters available and examples of where you may use them.

Operator
=
<>
>
=>
=<
<
LIKE

Description
Is equal to
Is not equal to
Greater than
Greater than or Equal to
Less than or Equal to
Less than
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Example
Everyone in Administration
Everyone except Administration
Greater than a date or value
Greater than or Equal to a date or value
Less than or Equal to a date or value
Less than a date or value
Use % as a wildcard to show all the Managers by entering % Manager in
05/07/2011

the Job Title Field
As above but showing everyone except the Managers for example
Between 2 dates or values (i.e. Pay). Use a comma (,) to separate the
values
Outside of 2 dates or values (i.e Show people who earn under £10000 and
over £20000. Use a comma (,) to separate the values
Everyone in Administration, Human Resources etc. Use a comma (,) to
separate the values
As above but the opposite (i.e. all EXCEPT the values)
Shows all records where the chosen field has no value. (Ideal for seeing
which records do not have a data of birth for example)
Shows all records where the chosen field has a value

NOT LIKE
BETWEEN
NOT BETWEEN
IN LIST
NOT IN LIST
BLANK
NOT BLANK

1.3.4 AutoSearch
The AutoSearch tool is an excellent tool for quickly applying filters to a report without having to open it in EDIT
mode each time you want to make a change. This is also invaluable for users who do not have security privileges
to edit reports.
To activate AutoSearch, simply click the AutoSearch tick box whilst setting up a Search criteria in the Query
designer. When you now preview the report in the PREVIEW tab you will see a magnifying glass icon on the
toolbar. Click this to change the search criteria.

1.4 DESIGN tab Overview
Once you have changed the criteria of the data within your report, you will need to change the appearance of the
report so that it is suitable for printing. This is all done within the DESIGN tab.
The DESIGN Tab consists of a toolbar and the main layout of the report where changes can be made to alter the
appearance of the report.
This page is split into sections (these will depend on what was selected during the set up stage in the Report
wizard). Each section is divided by a grey bar and these can be moved up and down the page by clicking and
dragging them.
Each section is labelled on the grey bar directly below the relevant section prefixed by an up Arrow symbol.
The following are sections which should appear on virtually all reports by default:
Description
Title
Header
Detail
Footer

Explanation
Items in this section only appear at the very top of the report
Items in this section appear at the top of every page (Except page 1)
This is where the bulk of the information is displayed
Items in this section appear at the bottom of every page (Except page 1)

The following sections may also appear on some reports:
Description
Group Header
Group Footer
Summary

Explanation
Used in reports which are grouped by a field in the database (such as Department)
As above, but used to show totals by a field (again, Headcount by department)
Items in this section only appear at the very bottom of the report – ideal for grand totals
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You will also see in the DESIGN tab that within the sections are a number of boxes, called objects. These objects
are basically the chosen fields and labels which are used as headers to show which field is which on the report.
To resize and object simply click on it and 8 black dots called ‘sizing handles’ will appear. Click and drag on the
relevant sizing handle to resize the object.
To move an object, simply click in the centre of the object and drag it into position.
1.4.1 Using the Page designer toolbar
The Page Designer toolbar is series of buttons, which allow us to Add different types of fields to the report (such
as calculated fields) and edit the caption within labels.
We can also add the SUMMARY section to the report by choosing SUMMARY from the REPORT drop
down menu
1.4.2 Placing Objects
You may wish to add a field (or other object such as a line) to the report, or you may want to add a calculated field
to the report to show a grand total for example.
The top part of the Page Designer toolbar is essentially split into two. The first series of buttons relate to objects
which are not connected to data in the database (called the Standard Components toolbar), the second series of
buttons all link to data/fields in the database and are typically prefixed with “DB” before the description (called the
Data Components toolbar)
Below this toolbar is the EDIT toolbar which is where we change the caption within a label or assign an object to a
field in the database To the right of this is the FORMAT toolbar which is where we can change the font etc.
If you wish to add a field to the report, you need to ensure that this has been added in the DATA tab first.
To add a simple label:
1.
2.

Click on the LABEL button on the Standard Components toolbar
Click on the page where you want to place the label

Once the label is added you will see a box appear on the EDIT toolbar with something like “Label4” in it. To
change the caption in the label, simply click in this box, delete the existing caption and type a new one in.
NOTE: You cannot change captions in labels within the label itself.
To add a database field:
1.
2.
3.

4.

Click on the DBLABEL button on the Data Components toolbar
Click on the page where you want to place the field
Two boxes will appear on the EDIT Toolbar, the first is related to the data pipeline and can be ignored,
the second box is called Data Field and here we can click on the drop down and choose a field which we
want to link to the DBLABEL object which we have added to the report.
Preview the report.

1.5 Other Report features
1.5.1 Editing Reports
You will often wish to edit an existing report. To do this, simply right click on the chosen report and choose open,
this will open the report in EDIT Mode. If you double click on a report it will open it in Preview mode only.
1.5.2 Deleting a Report
1. Click the Reports button on the Tools toolbar.
2. Select the report you want to delete and click the Delete button (a button with a red X on it).
3. Click YES to confirm
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NOTE: Once you have deleted a report it cannot be retrieved.
1.5.3 Printing
To print a report, simply click the PRINT button on the toolbar whilst in the PREVIEW view.
If you wish to change the Print Setup, choose PAGE SETUP from the FILE Menu. From here you will typically only
change the paper size, and the orientation (Portrait or landscape).

1.6 More advance report writing
The following examples show some of the more advanced features of report writing such as using more than one
table, adding totals, changing formats etc.
1.6.1 Summary Report showing Salaries by department – uses more than one table.
In this example we will be using two tables, Employee Details and Current Pay Details (this is used when
producing most pay reports, NOT Pay History).
When we choose two tables (rarely will we choose more than 2), the wizard automatically asks us how we want to
JOIN the tables together. Again in the majority of reports you will choose a simple JOIN and therefore JOIN types
are not covered in great detail on the Advanced Course
1.6.2 Working with Multiple tabled reports
If you include more than one table in your query, you must join the tables (for example, a column from left table
and a column from the right table) so that the rows in each table are joined to create one larger table. Usually this
column is the same in the right table as in the left table, such as StaffNo. (PK indicates the primary key field in the
table).
All rows from the left table and all rows from the right table are included if values meet the retrieval criteria. If
values do not meet the retrieval criteria, their rows are omitted.
This can get very complicated. The following table shows the different kinds of JOIN TYPES and describes what
each one does.
Join Type

Description

Inner

Returns only records that are matched in both tables (records in the left-hand table that do not
match a record in the right-hand table are ignored, and vice versa
Returns all entries in both left and right-hand tables
Returns all records in the left-hand table and any matching records in the right-hand table
(records in the right-hand table that do not match records in the left-hand table are ignored)
Returns all records in the right-hand table and any matching records in the left-hand table
(records in the left-hand table that do not match a record in the right-hand table are ignored)

Full Outer
Left Outer
Right Outer

HOT TIP: It is worth noting; JOIN types should ideally only be linked by the primary key fields (i.e. pkCandidates)
in each table and only by EQUALS TO (=). The wizard automatically tries to join all matching fields.

A. DATA - Build the Query
1.
2.
3.
4.
5.

Click on the Report button on the toolbar.
Select New Report (Button or File menu)
Select Query Wizard, OK
Choose Tables, Employee Details and Current Pay Details
When the Join Tables dialogue box appears make sure only the Employee Details field is linked and by an
(=) EQUALS TO Join, then simply click OK
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6.
7.
8.
9.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

Next
Choose the fields you wish group the data by, for this summary report (i.e. Department)
Next
Add Calculations, by double clicking on the chosen field (i.e. Annual Pay), this will open the Calculate Fields
dialogue box.
Choose the calculation (i.e. Sum) and press OK.
Create a Headcount calculation by, double clicking on any text field from the Employee Details screen (i.e.
Employee Number).
Then choose Count as the Calculation. When you click OK, the calculation will look as follows, Count(*).
Next
Select Group Fields will automatically select the fields chosen in step 9.
Next
Next
Next
Enter a name for the report.
Finnish
Click on OK to close the Preview Data screen
Follow the Design section below to create the actual report.

B.
10.
11.
12.
13.
14.
15.
16.
17.
18.

DESIGN - Create the report and edit the layout.
Click on the design Tab
Select New From File menu
Choose Report Wizard
Choose fields (these are the fields chosen in the Data section) i.e. Department, Sum(Annual Pay) & Count(*).
Next
Next
Next
Next
Finish

10.
11.

You should automatically be shown the preview
HOT TIP: It is worth noting, JOIN types should ideally only be linked by the Employee Number in each table and
only by EQUALS TO (=). The wizard automatically tries to join all matching fields so on reports which include
Training History it will try to Join the LOCATION field as well as the Employee Number.
The following steps explain how to edit the report to make it more suitable. These steps can be applied to other
reports that you create.
CHANGE THE TITLE OF THE REPORT
1. Click on Design Tab
2. Click on the Report title
3. Edit it to "Salaries by department", by clicking in the edit text box on toolbar and typing the correct title.
4. Click on preview tab to see the results
MOVE THE FIELDS INTO THE RELEVANT SECTION TO GET THE CORRECT REPORT LAYOUT
1. Select the Grouped field and the Calculated field (in this case Department and Sum(Annual Pay)
respectively).
2. Move these fields to the Group footer (Department) section.
3. Click on preview tab to see the results
CHANGE THE FORMAT OF THE CALCULATE FIELD
1. Select the field (Sum(Annual Pay), by clicking on it
2. Right click on it to open the options menu
3. Choose the DisplayFormats option.
5. Choose the -1,234.00 format for this example
6. Click OK.
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7.

Click on preview tab to see the results

ADD A GBP SIGN (£)
1. Clicking on the add Label button on the toolbar
2. Click where you want it to be placed (left of the Annual Pay field)
3. Change the text in the Edit Text box on the tool bar to a £ sign.
4. Click on preview tab to see the results
ADD A GRAND TOTAL
1. Click on the Design tab
2. Select SUMMARY from the REPORT menu to add a summary section to the report.
3. Click on DBCalc button on toolbar.
4. Click in Summary section to add the DBCalc field.
5. Choose the field to be calculated i.e. Sum(Annual Pay) from the field list.
6. Repeat the above step, but choose Count(*) field to get a total headcount.
7. Right click on the Calculated fields to open the options menu.
8. Select Calculation option
9. Set the Calculation to SUM & Press OK.
8. Click on preview tab to see the results
SAVE THE REPORT
1. Select SAVE from File Menu
2. Choose the destination folder (where the files is to be saved)
3. Click OK.

1.6.2 Producing Detailed reports with totals.
In this example we will produce a report grouped by Department, showing names, jobtitles and salaries with a total
salary by department.
A.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.

DATA - Build the Query
Click on the Report button on the toolbar.
Select New Report (Button or File menu)
Select Query Wizard, OK
Choose Tables
If choosing more than one table, Click OK when the Join Tables dialogue box appears.
Next
Choose the fields you wish use in the report (i.e. Department, Postname, Jobtitle, AnnualPay & Surname*)
Next
No Calculations, Next
No Grouping, Next
All Rows, Next
Natural Order (we will do this manually later), Next
Enter a name for the report.
Finnish
Click on OK to close the Preview Data screen

*By selecting Surname, this will allows us to sort by Surname, without actually having it to appear in the report.
TO SORT THE DATA
In order to group the report properly, we must set the order of the grouped fields, in this case department by…
5. Click on the A-Z button in the data tab.
6. Double click on the fields we wish to sort, in this case, Department and Surname.
7. This will move these fields into the Selected fields view (bottom section of the screen.)
8. Click OK
SEARCH – FILTERING THE DATA
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6.
7.
8.
9.
10.

Click on the Search button (Magnifying Glass Icon).
Choose the field you wish to filter, i.e. Job Title
Click on Operator field and choose "Like" from the list
Click on the Value field and type "% Manager". This will only show the managers in the current database.
Click OK

NOTE: To remove a field from the Selected Fields, simply double click on it.
B.
1.
2.
3.
4.

5.
6.
7.
8.
9.

DESIGN - Create the report and edit the layout.
Click on the design Tab
Select New From File menu
Choose Report Wizard
Choose fields to appear in the report (these are the fields chosen in the Data section) i.e. Department,
Postname, Jobtitle and Annual Pay. NOTE We don't choose Surname as we don't want it to physically
appear within the report.
Next
Choose the fields which are to be grouped, in this example choose Department.
Next
Next
Finnish

We then need to edit the layout of this report as follows:
CHANGE THE TITLE OF THE REPORT
1. Click on Design Tab
2. Click on the Report title
3. Edit it to "Detailed Salaries by department", by clicking in the edit text box on toolbar and typing the correct
title.
4. Click on preview tab to see the results
CHANGE THE FORMAT OF THE CALCULATE FIELD
1. Select the field (Sum(Annual Pay), by clicking on it
2. Right click on it to open the options menu
3. Choose the DisplayFormats option.
4. Choose the -1,234.00 format for this example
5. Click OK.
6. Click on preview tab to see the results
ADD A GBP SIGN (£)
1. Clicking on the add Label button on the toolbar
2. Click where you want it to be placed (left of the Annual Pay field)
3. Change the text in the Edit Text box on the tool bar to a £ sign.
4. Click on preview tab to see the results
ADD GROUP TOTALS
1. Click on DBCalc button on toolbar.
2. Click in Group Footer section (I.e. Department) to add the DBCalc field.
3. Choose the field to be calculated i.e. Annual Pay from the field list.
4. Right click on the Calculated field(s) to open the options menu.
5. Select Calculation option
6. Set the Calculation to SUM & Press OK.
7. Click on preview tab to see the results
ADD A GRAND TOTAL
1. Click on the Design tab
2. Select SUMMARY from the REPORT menu to add a summary section to the report.
3. Click on DBCalc button on toolbar.
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4.
5.
6.
7.
8.
9.

Click in Summary section to add the DBCalc field.
Choose the field to be calculated i.e. Sum(Annual Pay) from the field list.
Right click on the Calculated field(s) to open the options menu.
Select Calculation option
Set the Calculation to SUM & Press OK.
Click on preview tab to see the results

SAVE THE REPORT
1. Select SAVE from File Menu
2. Choose the destination folder (where the files is to be saved)
3. Click OK.
1.6.3 Creating a cross tab report
Cross tab reports are reports, which work on a table basis, rather than a simple text report.
In this example we will create a cross tab report which shows the total days lost by department and category.

A. Selecting the data
1.
2.
3.
4.
5.

Click on the Reports Icon on the tool bar
Double click on the folder where you want to save this report
Click New Report
Click OK
Choose Employee Details and Holiday and Absence tables ensuring that they are only joined by
employee number
6. Click Next
7. Choose Department, Category and Days Lost fields
8. Click Next
9. Click Next until you get to the final screen
10. Enter a description and click Finish
11. Click OK

B. Design the report
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Click on the Design tab
Choose NEW from the FILE Menu
Choose Cross Tab wizard
Click OK
Choose Orientation
Click Next
Drag the Category field into the NEW COLUMN box
Drag the Dept field in to the NEW ROW box
Drag the Days lost into the NEW VALUE box
Click Next
Click Finish

To edit a cross tab report:
1.
2.
3.
4.
5.

Click on the design tab
Right click on the Cross Tab1 box and choose CONFIGURE
Move your fields around as desired
Click Finish when complete
Click on Preview tab to view the results
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1.6.4 Creating a report with a graph
This Example we will create an Absence by day of the week report with a graph

A.

Data
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

Click on the Reports Icon on the tool bar
Double click on the folder where you want to save this report
Click New Report
Click OK
Choose Holiday and Absence tables
Click Next
Choose the Category field`
Click Next
Select Day Lost as the calculated field and set it to SUM
Click Next
Click Next until you get to the final screen
Enter a description and click Finish
Click OK

B. Design the report
1.
2.
3.
4.
5.
6.
7.
8.

Click on the Design tab
Choose NEW from the FILE Menu
Click OK
Select both fields
Click Next
Click Next
Click Next
Click Finish

C. Adding the graph
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

In the Design tab, choose SUMMARY from the REPORT menu
Click on the DBChart button, then click in the Summary section
Right click on the chart and choose EDIT CHART
Click ADD and choose a PIE Chart
Click on the SERIES tab
Click on the DATA SOURCE tab
Choose DATASET from the drop down menu
Choose the only option in the dataset drop down
Choose Category from the Labels drop down
Choose Sum(days lost) from the Pie drop down
Click Close

You can further edit the chart properties by opening the design tab and choosing Edit Chart from the right click
menu.
1.6.6 Using Global data within a report
It is possible to change the data source when creating your report so that it uses data from the global database
instead of the employee database.
To do this:
1.
2.

Click on the Reports Icon on the tool bar
Double click on the folder where you want to save this report
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3.
4.
5.
6.
7.
8.
9.
10.
11.

Click New Report
Click CANCEL
Choose DATA SETTINGS from the FILE meu
Choose CSGlobalData from the Database Name field
Deselect the DATA DICTIONARY checkbox
Click OK
Choose NEW from the FILE menu
Click OK
Proceed to create your report as normal using the global data tables rather than the employee data
tables

Ideas for use:
•

To print a list of Employee numbers by which groups they are in use CSCURRENTDATABASE (whilst
Datadictionary is deselected)

•

To print details of company cars use CSGLOBALDATA (whilst Datadictionary is deselected)

1.7 Hot tips for report writing:


If grouping by Individual, you will always use the Employee Number field and group by it.



Don’t forget, to only view an existing report, simply double click on it, however if you want to edit this report
you must right click on it and then choose OPEN.
Don’t forget to Preview your report after making each change where possible, this will ensure that if you



make a mistake, you spot it early.


To add a grand total for your report in this case don’t forget to add a summary section



Don’t forget that if you Group a report, you must also Sort by the grouped field



By right clicking on a DBText field you can choose a number of other options such as change the format of
the data within the field – for example change a number to 2 decimal places.

1.8 Report Scheduler Module
The report Scheduler allows you to send specified reports to an individual via email via a scheduled task. This
means that month end reports can be sent to managers on a specific date each month AUTOMATICALLY.
1.8.1 To set up a new Scheduled Report:
1.
2.
3.
4.
5.
6.

Open the report Schedule Module from START>PROGRAMS>VIZUAL BUSINESS TOOLS>REPORT
SCHEDULER>REPORT SCHEDULER
Click the NEW SCHEDULED REPORT button
Select a report from the drop down list
Select the database you want the report to be run from
Select the frequency for generating the report and the start date
Choose an email option (Personnel Address Book, Custom Contact List or Personnel Director Database
- NOTE: If choosing PD Database as a source for your contact list, the employees within that database
will need to have their email addresses entered correctly.
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7.

8.
9.

Choose the contacts who you wish to report to be sent to by double clicking on the contact in the left
hand list? – You may have to set up your contact list first if you chose Custom Contact list in the
previous step)
Press OK when your list of recipients for this report is complete
Press OK to scheduled the report

NOTE: In order to use the reports Scheduler you must first install it from the Personnel Director CD – refer to the
user guide (or the upgrade guide) for instructions on how to install the report Schedule module
NOTE: The Report Schedule Module is only available with the latest version of Personnel Director (currently
3.6.2.0)
NOTE: You will also need to edit each user’s security profile to allow them to have access to the module – refer to
section 5.3.1 of this manual for instructions.
1.8.2 Modifying a report schedule
To modify a scheduled report:
1.
2.

From the list of scheduled reports, double click on the scheduled report you wish to edit
Make the changes as required and click OK to save changes

NOTE: You can only modify the following options:
•
•
•
•

Frequency of the scheduled report
The database from which the report is generated
The List of Recipients
Parameter Values

1.8.3 Copying a report schedule
This is useful if you want to send the same report to the same people but generate it from a different databases
(i.e. in order to show all starters within the month from both live and archive databases), or where the parameters
are different, for example you wish to generate a Employee Absence Allowance report departmentally, where you
change the parameters to send each different departments details to the relevant manager etc.
1.
2.
3.
4.

From the list of scheduled reports, click on the one you wish to copy
Click on the COPY SCHEDULED REPORT button
Make the changes as required
Click OK to SAVE

You will see that the Report name will remain the same but with a different suffix
1.8.4 Deleting a scheduled report
To delete a scheduled report, simply click on it with in the Scheduled Report list and press delete on the toolbar

1.8.5 Working with Archived reports
Once a report has been sent, a copy of it will be archived for future reference.
1.
2.
3.

To view an archived report
Click on the Report Archive tab
Click on the report you wish to preview and press the preview button on the toolbar

NOTE: You can print the report from this screen
1.

To email an Archived report:
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2.
3.
4.
5.

Click on the Report Archive tab
Click on the report you wish to email
Click on the EMAIL SELECTED ARCHIVED REPORT button on the toolbar (this opens MS OUTLOOK
Email window
Choose a recipient, enter a message and send

To Purge Archived Reports
1.
2.
3.
4.

Click the Report Archive Tab
Click the Purge button on the toolbar
Select the date (Archived reports that were created on or before this date will be permanently removed)
Click YES to confirm
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2. Utilities
2.1 Batch Inputs
A Batch input is a tool which can be used in conjunction with a group or a filter to create new records for more
than one employee simultaneously. A good example of this would be when you have a group of employees who
have attended the same Training Course, or if you would like to create a Holiday for all your employees over the
Christmas period, known as Company Shutdown.
NOTES: You will need to create your group or filter before starting the Batch Input.
You may also wish to back up your database before starting the Batch Input in case you make a
mistake.
To create a Batch Input
1. Choose BATCH INPUT from the TOOLS drop down menu.
2. Click NEXT on the first screen.
3. Choose the Sub-Screen you wish to add a record to (E.G. Training History), Click NEXT
4. Choose the fields you would like to add data into, Click NEXT
5. Choose Group, Filter or Manually Select Employees to determine who will be given this new record, Click
NEXT.
6. Enter the data for the first employee in the list.
7. Then click on the Duplicate Values button on the toolbar, ensuring that the employee where you have typed
in the data is still selected.
8. Click YES. These 'values' will then be pasted into all of the selected employees to save you from having to
type them all in again.
9. Once complete press the Save Icon (Perform Batch Input button) and Click YES
10. Click OK
11. Click FINISH
Please remember Batch Inputs are not reversible. Take care when typing in the Values (data) in the Batch Input to
avoid any spelling mistakes etc, otherwise you will either have to restore the backup you made previously or you
will need to go through each employee where a new record was created and manually amend the mistake.

2.2 Global Updates
Global Update is an excellent tool which works in similar way to Batch Inputs. Where it works best is where say
the name of one of your company departments has changed and you wish to update the database without having
to manually change each individuals record. This is explained in the following example where we would like to
change the “Sales & Marketing” Department to “Sales”
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.

Within Personnel Manager, choose GLOBAL UPDATE from the TOOLS drop down menu
Click OK (It is worth noting that if you do not do a backup the changes you make cannot easily be
recovered if it goes wrong).
Click NEXT
We wish to select from All Employees (although a Filter/Group could be used, if it had already been
setup), Click NEXT.
Choose the screen you wish to update, in the case Employee Details, Click Next
We are updating Existing records so click Next
We want to select from all records, so click Next
Here we make our selection of which records will be updated (In this case it will only update the
employees with “Sales & Marketing” in their Department field), Press ADD
Choose the Department field from the drop down and click OK
Here we simply want to select the department we wish to change in this case Sales & Marketing. If the
value is not in the drop down, simply type it into the empty box
Click ADD and Click OK
Click Next
Here we enter what the new value will be for the chosen field, Click ADD
Choose DEPARTMENT as the Field
SET TO will be selected as the operator by default
Enter the new Value, in this case “Sales” into the Value box
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17. Click OK
18. Click Next
19. At this point you can still cancel the update if you are unsure. Otherwise click Next again to perform the
Global Update.
20. It may take a few seconds for it to perform the update depending on the number of records to be
updated. Once complete press Finish to exit the wizard.
Again, take care when performing Global Updates, as mistakes are very difficult to rectify. Ensure you are clear on
what you are doing before you run the update.

2.3 Archive and Transfer
When an employee leaves the company, you would not want to delete their records in case they decide to return
or you may be required to write a reference for them etc.
Note: There is a database entitled ‘Archive’ where all left employees information will be stored by default.
However by using the Transfer option detailed in this manual, you can place employees in any database you wish.
Employees can either be archived individually, (Archive Employees), or as a group, (Archive Leavers).
Archiving Employees
2.3.1 Archive an employee:
The current record employee details screen needs to be displayed on the main screen opened for the employee to
be archived
1. Select Employee using the navigator
2. Select ARCHIVE EMPLOYEES from the EMPLOYEE drop down menu
3. Select CURRENT EMPLOYEE
4. Click OK
5. Confirm Action
2.3.2 Archive Leavers
Note: Ensure that when you enter a date in this function that it is the correct date.
1. Select Employee using the navigator
2. Select ARCHIVE LEAVERS from the EMPLOYEE drop down menu
3. Select the date that will archive all employees with a leaving date on or before that date
4. Click OK
5. Confirm action
The employee details are now archived in the archive database.
IMPORTANT NOTE
The following rules apply for transferring an employee to another database.
The Employee Number of the Employee that you want to transfer cannot be used by an existing employee
in the target database
If you are using the multi-user version of Personnel Manager, you cannot transfer an employee if another
user is editing any of the employee’s details.
Note: When you archive an employee, All their history and sub record information is archived with them.
Therefore, unlike some personnel systems, you can archive and unarchive an employee as often as you wish,
without the fear of losing data.
To view employees in the Archive database simply use the ‘Open Database’ function to open the Archive.
2.3.3 Transferring Employees
This Data can be transferred back to an active Personnel database at any time, by accessing the archive
database and selecting transfer employees.
1. Open the database where the employee you wish to transfer's record is located.
2. Select Employee using the navigator
3. Select TRANSFER EMPLOYEES from the EMPLOYEE drop down menu
4. Click OK
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5.
6.
7.

Choose the Database where you want this employee to be transferred to
Click OK
Confirm action

Note: This process will transfer an employees information from one database to another, therefore this process
should only be carried out by the System Administrator.

2.4 Working with Work Periods
Calculations of absence days lost and hours lost can be based on Company Pay Periods (where all employees
work fixed hours and days) or on an employee’s work periods (where employees work varying hours and days).
To set work periods, you define one or more master work period and then assign them to individual employees.
Calculations for any employee not assigned a work period will be set to the company pay periods.
NOTE: Refer to the Set Up Manual from asap management ltd to see how to ensure Personnel Director is set up
to use Work Periods
2.4.1 To define a master work period
1.
2.
3.
4.
5.

6.
7.
8.

Open COMPANY>WORK PERIODS
Insert a new work period by clicking on the INSERT (+) button
Enter a name for the Work Period Master
Select the day you wish to include by clicking the checkbox to add a plus sign
Enter the starting and ending hours for that day. The hours worked will automatically be calculated or
alternatively you can over write these by typing the hours in (in case you do not want to include breaks
etc)
Repeat above for each day you wish to include within the work period
Click the Save (tick) button to save the changes
Click OK to save the work period.

2.4.2 Assigning Work Periods to Employees
1.
2.
3.
4.

Choose EMPLOYEE>EMPLOYEE WORK PERIODS
Choose the period you wish to assign from the drop down list
Identify which employees will be assigned by selecting an Individual, a group or a filter (Groups and
Filters may need to be set up first.
Click OK to assign the Work Periods to the selected employee(s)
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3. Screen Designer
3.1 General Overview
The screen designer allows you to customise existing screens or create new ones. You can also use the Screen
Designer to edit the Employee Record Card and other Personnel Manager screen prints and create customised
help for your Personnel Manager users.
The screen designer is very simple to use yet is quite a powerful tool, therefore great care is
recommended before designing new fields or more importantly editing existing screens.
To open the Screen designer module:
1.
2.
3.

Close Personnel Manager
Open the Security Module by clicking START>PROGRAMS>VIZUAL BUSINESS
TOOLS>PERSONNEL MANAGER>SCREEN DESIGNER.
Enter your username and password

Note: You can log in to the Screen Designer module only when no other users are logged in to Personnel
Manager, Diary, Diary Monitor, Database Maintenance, or Security Manager.

3.2 Making Changes to an existing Personnel Manager Screen
For this example we will make changes to the benefits screen by adding a notes field to enable you to record more
information about your employees’ benefits.
In the screen designer:
1.
2.
3.
4.
5.
6.
7.

Open the Benefits screen by clicking the OPEN button on the toolbar and double clicking on BENEFITS.
On opening two additional screens, Screen Properties and Field Chooser will also open.
Click the NEW button on the FIELD CHOOSER to open a Field properties box.
In the Field Name box, type Notes.
Select Notes from the Type drop-down list.
In the Display Label box, type Notes.
In the Description box, type Notes relating to employee benefit.
To save the new field, click OK.

The field you just added will now appear in the Field Chooser screen.
To add this field to the Benefits screen, simply click on the new field in the field chooser and drag it into position on
the Benefits Screen.
You may want to provide instructions on when and how to use it for your users. To do this, you create a screen
note. Screen Notes are a handy way to provide additional help for your users.
1.
2.
3.
4.

Click the Screen Properties button.
Click the Screen Notes Pick list
Replace the text on the screen with Use the Notes field to provide additional information about the
employee’s benefits.
Click the Save button on the Screen Notes to save the changes.

To save your changed Benefits screen, click the Save button on the File toolbar.
To Exit Screen Designer, select Exit from the File menu.
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3.3 Creating new screens
Prior to jumping in and designing your screen directly within the Screen Designer, it is important to have a clear
idea of what you want to achieve before starting it.
The following example is a new screen to track the equipment people borrow from a company and the table shown
in the following section shows how a screen can be planned out prior to designing it.
First we need to create a new screen (remember before opening Screen Designer, that all other users must be
logged out of any Personnel Manager module):
1. Click the NEW button on the Screen Designer toolbar
2. Enter a Screen Name (Loan Equipment) and a description
3. Click OK
3.3.1 Creating new fields
There are several properties which can be defined for new fields. These are split into the following sections:
Field

Where we set up the basic field properties such as name etc. NOTE: Some of these properties cannot be changed
once setup.
Field Name:
Type the name of the field. The name can contain the letters A to Z (upper or lower case) and numerals 1 to 9, but
can have no spaces.
Type:
Select the type of the field. It can be: Date, Decimal Number, Integer Number, Logical, Notes, Text, or Time.
Size:
If this is a Text field, type the maximum number of characters that users can enter.
Display Label:
Type the label to be displayed on the screen.
Description:
Type a description of the field.

Sorting

Determines whether or not this field can be used to sort by within Personnel Manager
Tip: Use this checkbox only when necessary. The more sort fields you have, the slower updating records becomes.

Display

To set the Display format - Depending on the type of field selected, the options vary. For example, if you selected a
text field, you can choose Normal, Uppercase, Lowercase, or Mixed Case format; if you selected a date field, you can
choose Long, Medium, Short, or windows default date formats.

Value

To set up calculated fields
Use the Build Expression screen to specify the formula for the calculation.
The result is updated when the user enters data in the fields used as the basis for the calculation and appears when
the user displays the screen.
To create the calculation, double-click the desired folders to display and select the Fields, Functions, Operations, and
Common Expressions you want.
Following are some examples of field calculations used in current Personnel Manager screens.
• To calculate the number of days between the date the employee joined the pension plan and today, determine the
number of days between the date when the employee joined and the current date.
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(Employee Details - LengthofService).
DATEDIFF([PensionSchemeJoin],Today())
• To calculate the total cost of an absence, add the cost of the absence, the
percentage of on-costs, plus the additional costs.
(Holiday and Absence - TotalCost)
[Cost] + ( ( [OnCost] / 100) * [Cost] ) + [AdditionalCost]
• To extract the year from the a date.
(Holiday and Absence - FromYear)
YEAR([StartDate])
• To calculate the difference between planned and actual structural training points.
(CPE/CPD Record - UnstructuredVariance)
[UnstructuredActual] - [UnstructuredTarget]
• To calculate double time.
(Pay History - DoubleTime)
[HourlyRate] * 2

Validation

To set up a validation formula for the field to force users to enter data correctly in this field
A Value Is Required For This Field:
Click this checkbox if the field is mandatory.
Validate This Field Before Saving:
Click this checkbox if the field must be verified before the record is saved.
Entering Field Validation Formulae
Use the Field Validation screen to enter a rule for the field. This rule is to be performed each time data the user enters
data in this field. If the data does not conform, the user receives an error message.
The validation rule must produce a true or false result; for example:
TotalCost > 1000 will produce a true/false result, whereas TotalCost * 1000
will not.
To create the rule:
1.
2.
3.
4.
5.

Double-click the desired field from the Field list.
Double-click the desired function from the Functions list.
Type the value in the Validation Statement.
Check the validity of the expression by clicking the Test Expression button.
Click OK.

Following are some examples of validation rules used in current Personnel Manager screens.
• To ensure that the end date of absence is greater than or equal to the start date.
EndDate >= StartDate
• To ensure that the equipment VALUE is greater than 1.
VALUE > 1
Display This Message If Validation Fails:
Type the message that is to appear if the verification fails.
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Picklist

Whether or not the field is a picklist and what type
This Field Has A Pick List:
Click this checkbox if this field is to be a Pick List.
A Value Must Be Selected From the Pick List:
Click this checkbox if a value must be selected from the list; if the user is to be able to add values, clear this checkbox.
• To add a value, click the Add button. Type the new value and click OK.
• To remove a value, select the value and click the Delete button. To confirm the
deletion, click OK.
If the items in the Pick List are values in another field in Personnel Manager click the More button.
The Pick List Options screen appears.
Pick List Type:
Select one of the following types:
Standard.
Create a standard Pick List. Users can add or remove items from this Pick List if you select the A Value Must Be
Selected From the Pick List checkbox on the Pick List tab.
Pick From Employee Data.
Create a Pick List from Employee data; for example, Post Names. Users cannot add or remove items from this type of
Pick List.
Pick From Company Data.
Create a Pick List from Company data; for example, Currency. Users cannot add or remove items from this type of
Pick List.

We are initially only concerned with the FIELD properties (more can be added later). The following table shows the
fields we want to include on our new Loan Equipment Screen and their properties:
Field Name
LoanOutDate

Field Type/Size
Type: Date

Display Label
Date

Description
Date equipment was loaned out

Returned

Type: Date

Returned

Date equipment is to be returned

Description

Type: Text
Size: 30
Type: Decimal Number

Description

Description of equipment

Value

Value of the equipment

EquipmentValue

To set up these fields:
1.
2.
3.

Click NEW on the Field Chooser
Enter the details as per the above table (the additional properties will be added later).
Click OK after each one is completed.

We then will edit the EquipmentValue field so that it shows the value to 2 decimal places
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1.
2.
3.

On the field chooser double click on the Value field (or Click to select and then press EDIT).
Click the Display Tab
Select 2 Decimal places from the format drop down and click OK

The fields are now set up and ready to be added to the screen. (We can edit these further at a later stage.)
3.3.2 Adding Objects to the screen
To add an object to the screen, simply click on the field you wish to add and drag it into position on the screen.
Repeat this process for each of the fields you wish to add.
NOTE: There maybe some fields which you wish to create for use in Filters etc. Simply create the fields in the field
choose but don’t drag them on to the screen and they will still be available for use in reports etc.
These are typically calculated fields for example BirthdayMonthName on the Employee Details Screen.
3.3.2 Editing Fields
In this example we will edit the Description field and change it to a picklist field.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Double click on the Description field in the field chooser to open the properties
Click on the Picklist tab
Click on the THIS FIELD HAS A PICKLIST option (so that it is ticked)
Click OK (Values can be added either at this stage or once we are back in Personnel Manager)
Click on the Description field on the Loan Equipment Screen (the box rather than the label) and press
delete
On the Controls toolbar (typically on the right hand side of the window) click on the Variable picklist
button and drag it into position on the screen
Whilst it is still selected right click and choose Control Properties
From the field drop down list choose the Description field.
Click OK

This links the Pick List control with the Description field.
To avoid wasted space on the form, you can reduce the size of the screen and play around with the layout of the
screen.
You may also find if fields are moved around the screen that the Tab order is incorrect within Personnel Manager.
If this is the case Click on the ORDER button on the Screen designer toolbar and move the fields into the desired
position using the up and down arrow buttons.

3.4 Deleting Screens
To reduce the number Personnel Manager screens to those only needed for your organisation, simply remove the
unnecessary screens from Personnel Manager.
This will simplify the interface for your users.
To Delete a screen:
1.
2.
3.

On the File toolbar, click the Open button or from the File menu, select Open Screen
Select the screen to be deleted by clicking on it
Press DELETE and click YES to confirm

Important Notes:
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• Deleting a screen in the screen designer not only removes the screen, but also removes its icon from the
Personnel Manager Shortcut bar, fields and all data associated with it.
• You can only delete screens you have created; you cannot delete screens delivered with Personnel Manager.

3.5 Changing the Employee Record Card
You can easily tailor the layout or content of the Record Card to better meet your organisation’s requirements
(This is the report generated when you select Print Record Card from the File menu or click the Print button when
viewing Employee Details in Personnel Manager.)
To do this, select Modify Employee Record Card from the File menu, change the layout and the content as desired
and when you are finished, save your changes and exit the Report Designer.

3.6 Designing Screen Prints
Screen Prints are similar to the Employee Record Card. Each sub record (Screen) has a Screen Print which can
be customised and you can create a new Screen Print for any new Screen which you design.
Note: If you do not create a screen print for screens you create, a rudimentary printout is generated.
To open and existing Screen Print, simply open the screen you wish to view the screen print for whilst in the
Screen Designer module. Then choose the Design Screen Print option from the file menu.
3.6.1 About the Screen Print Window
When you create a new screen print or open an existing screen print with Screen Designer, a window will appear.
As with other Personnel Manager reports, the screen print report is divided into three sections:
Header, Detail, and Footer.
When you create a screen print for a new screen, Screen Designer displays a blank screen print report with the
company logo and screen name in the header and the page number in the footer.
When you are modifying an existing screen print, the fields appear in the Detail section.
Use the various toolbars to create layout required by adding, removing, positioning, and formatting fields
previously defined for the screen.
Build or modify the layout by placing and arranging objects using the tools on the following toolbars.
• Standard Components
• Data Components
• Format
3.6.2 Viewing the Toolbars
Only the Standard Components, Data Components, Format, and Edit toolbars are shown when you first open a
screen print.
To display and use the other toolbars, follow this procedure:
1.
2.

Select View from the Toolbars menu.
Select or deselect the active toolbars from the drop-down menu.

A checkmark means that the toolbar is active.
3.6.3 Example - Modifying a screen print layout
In this example, work through each step in modifying the existing screen print layout for the Vehicle Usage screen
provided with Personnel Manager.
You decide to move the Usage Type label and field, and add the Vehicle Usage Notes label and field to the end of
the line:
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1.
2.

Open the Vehicle Usage screen.
Select Design Screen Print from the File menu - The Screen Designer - Vehicle Usage Screen Print
screen appears.
3. To move the Usage Type label and Type field to a temporary location, click and drag the Detail
separator bar down to increase the space in the Detail section.
4. Then press the shift key and click both the Usage Type label and Type field and drag them down into
the body of the Detail section. Deselect these fields by click elsewhere on the page.
5. Press the shift key and click the Date label, Date field, Vehicle label, and Registration and drag them to
the left until positioned to the left of Miles Travelled. Deselect these fields by click elsewhere on the page
6. To add a Notes label, click the Label button, then click in the Header to the right of the Miles Travelled
label to place the new label.
7. In the Label box in the toolbar, type Notes.
8. To add the Notes field, click the DBMemo button, then click in the Detail section on the right of the Miles
field to place the new Notes field. Adjust the size of the field as necessary.
9. Select Notes from the Field drop-down on the toolbar. Because content in the Notes field is variable –
that is in some notes the length could be one line and in another it could be several – the field properties
must be set so that the field grows with the content.
10. Right-click the Notes field and select Stretch from the shortcut menu.
11. Click the Save button or select Save Report from the File menu.
12. Preview the results by clicking the Screen Designer Preview tab.

Now return to Personnel Manager to check the result with real data.
Note:
When viewing the result of a screen print you modified or created while in Personnel Manager, be sure that there
are existing records or the report will be blank.
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4. Database Maintenance
4.1 Database Maintenance Overview
The Database Maintenance module is where the system administrator can perform key administrative tasks such
as recalculating the data, creating new databases, import data etc.
NOTE: You must have access to the Personnel Director Database Maintenance module before you can use
it.

4.2 Manage Database List
The database list determines which databases are visible to users (this will also depend on individual security
settings).
To add a database to the list:
Open MANAGE DATABASE LIST from the FILE menu
Type in the name of the database
Type in a description for the database
Type in the location of the database
Click ADD
Click TEST CONNECTION to make sure it works OK
Click OK
The location will vary on which version of PD you are using.
Interbase looks something like
SQL looks something like

servername:c:\pddatabases\NAME.gdb
servername.NAME.gdb

If you are not sure, check with the System Administrator
To delete a database from the list:
1.
2.
3.
4.

Open MANAGE DATABASE LIST from the FILE menu
Click on the database you wish to delete
Click DELETE
Click OK

If you delete a database from the list it DOES NOT delete the actual database. To completely delete a database
you will have to do this in the Interbase Server Manager

4.3 Create a new database
1.
2.
3.
4.
5.

Open The Database Maintenance Module
Click NEW DATABASE from the FILE Menu
Enter a name and description for the database
Click CREATE
Click OK when complete

4.4 Import data
You maybe required to import data into Personnel Director whether it be from another system to create a database
from scratch or to update key fields via import rather than manually editing the employees record.
NOTE: Importing of data using the Personnel Director Database Maintenance Module, requires exclusive
access to the system, therefore all other users will need to log out of Personnel Director for the duration
of the process.
2.4.1 The import Options
There are a number of options for importing data which will greatly effect what how the data is imported. Refer to
the following option guide to ensure you select the correct option. (It is recommended that you perform a backup
before importing any data)
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Importing Employee Details
Option
Ignore Duplicates
Ask on Duplicates then replace imported fields only

Ask on Duplicates then import all fields

Replace Duplicates - imported fields only

Replace Duplicates - all fields

Description
This will only import records where the employee number does not
already exist in the database
This option will warn you that a duplicate employee number has been
detected. If you choose to proceed with the import, only fields which
are different to the existing record will be imported in addition to
creating new records for any new employee numbers detected
This option will warn you that a duplicate employee number has been
detected. If you choose to proceed with the import, all the fields for
this employee will be imported, overwriting the existing data, in
addition to creating new records for any new employee numbers
detected
This option automatically imports any fields which differ in the
database. For example, where a new employee number appears a
new record will be created, If an employees address details differ
within the import file to that on the database, these fields will be
overwritten.
This option automatically overwrites all existing data where a
matching employee number is found. As above it will also add a new
record for any new employee numbers. It will not however, delete any
existing records on the database if they do not exist within the import
file.

It is essential that employee numbers remain constant when regularly importing data into Personnel Director (for
example, when updating records from another system)
Importing other information, such as Training History (Sub-records)
You basically have two options for importing data into a sub-record
Option

Description

Append imported records to existing

Here, imported records will be added to the existing employee subrecords
Existing record for an employee are deleted before importing the new
data.

Replace existing records with imported records

2.4.2 Setting up an import template/definition
Use the following procedure to set up a new Import wizard template/definition.
1. Open the Personnel Director Database Maintenance module.
2. Open the database you wish to import into
3. Click the IMPORT DATA button on the toolbar.
4. Select "I want to create and use a new import definition".
5. Choose file "filename.csv" by using BROWSE button.
6. Select "First row contains headings".
7. Ensure the date format is set to dd/mm/yyyy
8. Select the table which you want the data to be imported into using the "Import into table" field.
9. Click NEXT
10. Choose an import option (highlighted above)
11. In the Personnel Field column, map the fields in the data file to the fields in the table.
12. Select "I want to save these details as a template then import data now".
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13. Type in a name for the template
14. Click Finish
15. Your data should now be imported into the database, click OK when complete.
Re-using an Import definition/template
Once you have set up a Import Template it can be re-used to re-import data again and again as explained below:
1. Open the Personnel Director Database Maintenance module.
2. Open the database you wish to import into
3. Click the IMPORT DATA button on the toolbar.
4. Select "I want to use/edit an existing import definition"
5. Choose the Import definition (Template) you wish to use and click NEXT
6. Ensure that you select the correct file which is to be used to import using the browse button
7. Click NEXT
8. Click NEXT
9. Click NEXT
10. Click FINISH
11. Your data should now be imported into the database, click OK when complete.

4.5 Recalculate Database
When you have made any changes to the database such as adding new employees or Archiving and Transferring,
you may wish to refresh the database using the RECALCULATE tool. This is especially useful before printing off
reports
The Recalculate feature is used to update the Yellow, (automatically updated), fields within a screen. You may
also need to use the function if you found that these calculated fields were not being updated correctly.
An example of when you would run this feature is as follows:
If you enter an absence for an employee and they do not have a pay record, then the absence cost will not be
calculated. If you then entered a pay record for the emloyee, the absence cost would not be automatically entered
until you recalculate the absence record. Therefore, rather than have to individually enter each employees
absence records in order to update the cost fields, you would use the recalculate option.
1. Open the Database Maintenance Module
2. Open the Database you wish to recalculate
3. Choose RECALCULATE from the FILE menu
4. To recalculate the whole database, select ALL EMPLOYEES and ALL SCREENS, then click OK.
5. Once complete click OK
6. Click the CANCEL button to close the wizard.
TIP: If you click OK when finished, it will run the recalculate tool again.

4.6 Scheduling Recalculations
It is possible to schedule refreshes of the Personnel Director databases. These recalculations can be scheduled
on an hourly, daily or weekly basis.
NOTE: We recommend a daily recalculation which is set to run overnight when no users are logged on to the
system.
NOTE: You must have installed the Recalculation program from the Personnel Director CD-ROM. Refer to the
user guide for instructions on how to do this.
4.6.1 To schedule a recalculation
1.
2.
3.

Open the Recalculate Scheduler from START>PROGRAMS>VIZUAL BUSINESS
TOOLS>PERSONNEL DIRECTOR>RECALCULATE SCHEDULER.
Log on using your username and password
Set up how often you wish to run the recalculation
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4.

Click OK to save

4.7 Purge Data
It is possible to Purge large quantities of data from Personnel Manager by using the Purge Tool.
An example where you may use this tool is say if you had 5 years worth of Holiday and Absence records and you
no longer need more than 2 years history. What you can do in this case is purge all of the Holiday and Absence
records prior to a particular date.
Great care is needed when using this tool as records cannot be recovered once they have been purged.
To purge records:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Open database where data is to be purged
Select PURGE DATA from the FILE menu (or click the PURGE button on the toolbar)
Select which screen contains the Data that you wish to Purge, in this Holiday and Absence.
Choose the Date field, which is to be used to determine which data, is to be purged. (For example, you
could Purge all Holiday and Absence records where the Start Date is before 01/01/1999.)
Select either the BEFORE, BETWEEN or AFTER option
Enter the data you wish to use
Click CONTINUE to purge the data (or Cancel to exit the wizard without purging anything).
Click YES to continue
Click OK

It may be worth backing up your database before performing a Purge. Once data has been purged it
cannot be retrieved!

4.8 Populate Picklists
You may find that your picklists get untidy with many unused or misspelled values. There is a way to refresh these
picklists with the data in the database itself (there maybe values in the data which don’t appear in the picklist).
To do this simply
1.
2.
3.
4.
5.
6.

Open Database Maintenance
Choose the database you wish to use
Click on the Populate PickLists button on the toolbar
If you want to clear existing values tick the checkbox
Choose the maximum number of values in the lists
Click OK

This will effectively tidy up your picklists based on the data in the database. If you are not confident that the data in
the database is very tidy then it may not be best to run this utility.
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5. Security Manager
5.1 General Overview
The Security Module allows you to set up comprehensive security profiles to determine which users can see which
aspects of the system.
The security works on 5 levels:
•
Modules – Determines which modules the user can access (Security/Screen Designer/ etc)
•
Database – Determines which Databases the user can access
•
Screen – Determines which screens the user can access
•
Field – Determines which fields the user can access
•
Functions – Determines which Functions the user can perform
•
Employees – Determines which employees the user can see
To open the Security Module:
1. Close Personnel Manager
2. Open the Security Module by clicking START>PROGRAMS>VIZUAL BUSINESS
TOOLS>PERSONNEL MANAGER>SECURITY MANAGER.

5.2 Creating/Editing Users and Templates
Before creating a new security profile it is essential that thought is given to what exactly it is the user can do and
see.
To create a new user (From with the Security Manager Module):
Click New User button on the toolbar down the left of the screen, or choose New User from the FILE menu
1. Choose the “I want to specify all settings myself” and click NEXT
2. Enter a Username (this is the name the user will use to log in)
3. If the Users record is already stored on Personnel Manager click theStaff Number picklist to find the
employee. This will then automatically complete some of the details for you.
4. Enter the full name of the user
5. Enter a password for the user
6. Enter the same password in the confirm box and click NEXT
7. Enter in the details on this screen if required (Not essential) and Click Next
8. Click NEXT
9. Click Finish
This will create a new user who will by default have full access to Personnel Manager.
You will now need to remove access privileges where required as explained in the following sections:

5.3 Setting up Security Restrictions
There are 3 ways of opening the Security settings wizards, either right click on the user, from the Security drop
down menu or from the Security shortcut bar on the left of the screen.
5.3.1 Module Security
1. Click the user you want to change
2. Right click and choose Modules
3. Click to add/remove ticks on the options to make your selection.
Here we can decide whether or not the user can see the following modules:
Personnel Director
Security Module
Database Maintenance
Screen Designer
Self Service Administration
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In addition to this we can determine what level of access the user has to Self Service (Administrator, Manager or
Self Service Access).
Finally we can also choose whether or not to give the user access to the Report Scheduler utility and decide
whether they can View/Edit Schedules and/or View Archived Reports.
5.3.2 Database Security
1. Click on the user you want to change
2. Right click and choose Databases
3. Double Click on the Databases you DO NOT want this user to see and click NEXT
4. Click FINISH
5.2.3 Screen Security
1. Click on the user you want to change
2. Right click and choose Screens
3. Click NEXT
4. Double Click on the screens you DO NOT want the user to see and click NEXT
5. Double Click on the screens which you want the user to see BUT NOT Edit, click Next
6. Double Click on the screens which you DO NOT want the user to be able to Delete, click Next
7. Click Finish
5.3.4 Field Security
You will need to repeat this process for each screen where there is a field with restricted security
1.
2.
3.
4.
5.
6.
7.

Click on the user you want to change
Right click and choose Fields
Click NEXT
Choose the Screen which contains the field(s) you wish to change the access rights to , click Next
Double Click on the fields which you DO NOT want the user to have access to
Double Click on the fields which you want the user to see BUT NOT Edit, click Next
Click Finish

5.3.5 Function Security
Function Security is where you restrict the user from performing certain functions such as Archive an employee etc
TIP: If you are unsure if the user will need access to a particular function then prohibit it anyway – it can
always be added back later and it often proves to be better safe than sorry!
1.
2.
3.
4.
5.
6.

Click on the user you want to change
Right click and choose Functions
Click NEXT
Double click the functions in the Functions Allowed window to move them into the Functions Prohibited
Window, therefore preventing the user from performing the chosen functions.
Click Next
Click Finish

5.3.6 Employee Security
Employee security allows you to restrict access to an employees or a selection of employees.
NOTE: It is important to remember that this feature is one dimensional – you cannot prevent the user seeing pay
for one group of employees yet giving them access to another group within the same profile. To do this you will
need to set up 2 separate profiles.
1.
2.
3.
4.

Click on the user you want to change
Right click and choose Employees
Click NEXT
Press ADD.

Page 34 of 38
Property of Agathon Consulting 2011

05/07/2011

5.
6.
7.

Choose the field you wish to use as a filter (if it is just one employee to do not want the user to see, use
their employee number for example), Click OK
Click Next
Click Finish

5.4 Security Audit
The Security Audit allows you to track who has made what changes to which records within Personnel Manager.
To open the Audit utility, whilst in The Security Module, choose VIEW AUDIT TRAIL from the SECURITY drop
down menu.
From here you can Apply a filter to find specific information such as who made a change or what changes were
made on a specific date etc.
If you wish to disable the Audit Trail choose AUDIT TRAIL DISABLED from the OPTIONS drop down menu.
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6. Backup and Restore
6.1 Backing up and Restoring (Interbase Version)
In order to back up or restore a database you will need to have access to the Interbase Server Manager.
To back up a database:
1. Open the Server Manager (START>PROGRAMS>INTERBASE>SERVERMANAGER
2. Click on the SERVER LOGIN button on the toolbar (or from the FILE drop down)
3. Enter the SYSDBA password (it is not advisable to issue the SYSDBA password to other users)
4. Click on the BACKUP button on the toolbar (or from the TASKS MENU)
5. Enter the current location of the database (for example, c:\pddatabases\archive.gdb)
6. Enter the location where you want the backup to be stored (for example, c:\pddatabases\archive.gbk)
7. Press OK
8. Once complete close the Status window
9. Exit The Server Manager and click YES to close connections and Exit
To restore a database:
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Open the Server Manager (START>PROGRAMS>INTERBASE>SERVERMANAGER
Click on the SERVER LOGIN button on the toolbar (or from the FILE drop down)
Enter the SYSDBA password (it is not advisable to issue the SYSDBA password to other users)
Click on the RESTORE button on the toolbar (or from the TASKS MENU)
Enter the current location of the database (for example, c:\pddatabases\archive.gdk)
Enter the location where you want the backup to be stored (for example, c:\pddatabases\archive.gdb)
CHANGE THE PAGE SIZE FROM 1024 to 4096
Press OK
Once complete close the Status window
Exit The Server Manager and click YES to close connections and Exit

6.2 Backing up and Restoring (SQL Version)
Backing up and Restoring database on the SQL version of Personnel Director can only be done using SQL
Servers Enterprise Manager. Therefore please contact your IT administrator to perform and backup/restore.
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Appendix 1 - Glossary of Terms
DATABASE

Is the equivalent to a filing cabinet, which stores your employee information. You may have more
than one database for example, one to store leavers and one to store Current Staff.

RECORD

A record is similar to a file you may keep within a filing cabinet, where you have one file per
employee. This is the same with Personnel Director where, each employee has a record for
storing his or her details, (for example, Employee Details Screen). Each employee's record is
made up of sub-records such as Training History.

SCREEN

Is where we can clearly view the details of an employee's record. This is called the Employee
Details screen and only records the current information about each employee.

SUB-SCREEN

In addition to the Employee Details screen, we have Sub-screens, where we can record other
information such as Training History or Pay History. These are sometimes referred to as SubRecords or History Screens.

TABLE

Is where the data is actually stored within the database. Each table has a screen in order to view
the details more clearly. You may find that there are extra fields on a table than appears on the
screen. These are useful in Filters, Queries and Reports.

FIELD

Where we can add specific data about an employee. For example, the Department field is where
we enter which department the employee works within. There are several types of fields, Text
fields, Pick List fields etc.

DATA

Data is another word for Information or Details.

FIXED PICK LIST

Is a list of data relevant to a specific field where you cannot add extra items. For example, the
Gender Field.

PICK LIST

Is a list of data relevant to a specific field where you can add your own items. For example, Job
Title Field. NOTE: These can be set up as Fixed Pick Lists using the Screen designer.

FILTER

To enable you to work with selections of employees when giving pay rises, reviewing absence, or
sending letters for example.

QUERY

A tool which enables you to export a selection of employee data into MS Excel for example.

ARCHIVE

When an employee leaves, we can move their record to the another Database which is set up to
specifically store leavers. This is called the Archive Database.

USERNAME

The unique name assigned to the person using Personnel Director

WIZARD

A tool which guides you step by step guide through a process of screens
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Appendix 2 - Contacts

Agathon Consulting ltd
If you have any queries relating to Personnel Director (or other products in the Vizual range) or if you require
additional training or consultancy, please contact Agathon consulting by:

Phone:

01242 663974

Email:

enquiries@agathonhr.co.uk

Web:

http://agathonhr.co.uk
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